
Open Command (File Menu)
Use this command to add a new file to the current window.    Choosing this command will 
open a dialog box from which you can choose new a file to view.    If there is a special file 
viewer for the file, it will be shown in its native format.    Otherwise, it will be shown with 
either the ASCII viewer (if the file is made up chiefly of readable characters), or the Hex 
viewer.

When you open a file in this manner, the file will be displayed in the current window and its 
name will be added to the top of the "Filelist" menu.



New Window
When you click on the "New Window" button, Drag And View will open up a new window with
the same file list as the current window.    Choose this command when you want to view the 
same files in two or more windows at the same time.    You can then arrange these windows 
to view different parts of the same file side by side or choose another file from the file list 
and compare the two files.    You can open up as many new windows as you want, up to 
available memory on your computer.



Launch
Click on the "Launch" button to run the program associated with the file that you are 
currently viewing.    If you are viewing a data file or a picture, Drag And View will query 
Windows to find out the name of the program that you have associated with the file.    If 
there is an associated program, Drag And View will run that program and pass to it the file 
that you are currently viewing as a command line argument.    For example, if you are 
viewing a document from Microsoft Word for Windows, Drag And View will run Word for 
Windows and have it load up the document that you are currently viewing.    If you don't 
have a program associated with the file will present you with a dialog box letting you know 
that and allowing you to choose a program to launch.    

If the file you are viewing is a program, Drag And View will run it when you choose this 
command.



Save As Command (File Menu)
All the graphics windows will have a save as option on the file menu.    With this option you 
can save the file currently being displayed in 6 different bitmap formats.
BMP
PCX
TIF
GIF
JPG
TGA



Close Drag And View Command (File Menu)
Under Windows NT, closing all the Drag And View windows will not close the Drag And View 
icon.    You can use this menu option to close all the windows and the DV icon.



Select All Command (Edit Menu)
Use the “Select All” command to select all of the viewed file to print or copy to the clipboard.
Selected areas of text files, spreadsheets and databases will appear in reverse video.    
Selected areas of graphics files will have a rectangle around them.



Copy
The “Copy” button will be available only if part of the view has been selected.    You can 
select areas to copy by dragging the mouse over them or by choosing “Select All” from the 
“Edit” menu.    Clicking on the Copy button will copy the selected area to the Windows 
Clipboard.    All text, spreadsheet and database files will be copied as text.    All graphic files 
will be copied as bitmaps.    There is also a copy menu item on the “Edit” menu



Print
Clicking on the “Print” button will bring up a dialog box from which you can print a file.    If 
part of the file is selected, you will be able to print just the selection or the entire file.    
Spreadsheet, text and database files will be printed in the printer’s default font.    Graphic 
files will be printed the way they are displayed. The WAV file player and the Hex viewer do 
not allow printing.



Word Wrap (File Menu)
This command is only available in Drag And View's ASCII viewer.    Use this command to turn 
word wrap on or off when viewing ASCII files.    When word wrap is on, Drag And View will 
wrap each line at the current window width.    As you expand the width of the window, Drag 
And View will expand the length of the lines.    When word wrap is active, there will be a 
check mark before this command.    When you turn word wrap off, the check mark will 
disappear.



Fonts (Settings Menu)
This command will bring up a dialog box where you can choose which font you want Drag 
And View viewers to use.    The font that you choose will be active in all the viewers that 
display text except the Hex viewer.



Exit (File Menu)
Use this command to close the current window.



ASCII (View Menu)
Use this command to view a file in ASCII format.



Hex (View Menu)
Use this command to view a file in Hex format.    The Hex viewer displays a file as a series of 
hexadecimal (base 16) numbers and ASCII characters.    Each line in the Hex viewer has the 
starting offset into the file of the line, 16 characters of the line as hexadecimal numbers and 
then the same 16 characters as ASCII characters.



Viewer (View Menu)
Use this command to view a file with one of Drag And View's viewers that view the file in its 
native format.    This will be the default if a file format is supported by Drag And View.    The 
only reason you will need to select this command is if you changed to the ASCII of Hex 
viewer and now want to change back.



Edit (View Menu)
You can edit ASCII files of any size.    Choose Edit from the View menu and the viewer will 
turn into an editor.    You can save your work by choosing Save As from the file menu.



Goto
This button will only be active when viewing a database or spreadsheet, or in the Hex 
viewer.

For database viewing, this button will open up a dialog box where you can enter a specific 
record to go to and view.

For spreadsheet viewing, this button will open up a dialog box where you can enter a specific
cell to go to.

In the Hex viewer, this button will open up a dialog box where you can enter a specific 
hexadecimal offset into the file that the viewer will show.



Find
This button is active in all the viewers except the graphic and WAV viewers.    Use this button
to search for specific text in a file.    In all viewers except the    viewer you can specify that 
your search be case sensitive.    In the Hex viewer you can search in ASCII as well as 
hexadecimal.

Choosing this command will open up a dialog box where you can enter your search 
information.    Choosing OK will find the first match in the file.    Choosing OK each time will 
find each subsequent match.



Filelist (Main Menu)
The "Filelist" menu displays the names of all the files that have been dragged to the open 
window or opened from the file menu.    The file that is currently displayed has a check 
before the name.    Highlighting another file and pressing Enter or clicking on another file 
name with the mouse will display that file.



Close All Windows (Drag And View Icon System Menu)
Use this command to close all the currently open Drag And View windows.    Drag And View 
will still be running and its icon will still be displayed.



Close (Drag And View Icon System Menu)
Use this command to exit the Drag And View program.    All open Drag And View windows will
be closed at this time.



Zoom Command (Main Menu)
Use this option to quickly zoom in the view of your file up to 5X.    This command will be 
available with all files except WAV files and the Hex display.    Zooming will stay in effect only
for the current file being viewed.    If you view another file, the Zoom will go back to 1X



Page Command (Main Menu)
This command will not be available unless you are viewing a graphic or spreadsheet with 
multiple pages.    You can use it to view the additional pages of the file.    Drag And View 
currently supports multiple pages in Quattro Pro for Windows (WB1), Lotus 123 for Windows 
(WK4) and Excel version 5 (XLS) and Adobe Acrobat (PDF) files.



What is Drag And View?
Drag And View is a program that lets you view the contents of a file or files without having to
run the program that created them.    Drag And View can view the files created by popular 
word processors, databases, spreadsheets and bitmapped or vector graphic programs in 
their native format.    You can also view any file in plain ASCII or hexadecimal format. Drag 
And View has a built-in editor that will let you edit ASCII files under 64k in length. Drag And 
View allows you to open multiple windows so you can easily compare files.    You can search 
for text in any file or a hexadecimal string in the Hex viewer.    You can also go to any cell in a
spreadsheet, any record in a database and any address in the hexadecimal view of a file.    
Drag And View allows you to select all or any part of a viewed file and copy it to the 
Windows clipboard or print it.    Printing of text files will be done in the default font of the 
printer and will not necessarily be formatted the same way as the file when displayed by its 
parent program.    You can also Zoom in your view of a file up to 5 times the original file size.

Drag And View operates differently under Windows 95 and Windows NT.    Under Window 95 
the easiest way to view a file is to right click on the file you want to view in any Explorer 
Window and choose “Drag And View” from the menu that comes up.    If    you want to view 
more than one file, first tag the files that you want to view, then right click on the files and 
choose “Drag And View” from the menu.    If you want to open up additional Drag And View 
windows, choose the new window button from the toolbar.

Under Windows NT, you first run Drag And View.    When Drag And View is running it will 
appear as an icon on the lower left of your screen.    To view files you can drag the selected 
files from the File Manager to the Drag And View icon or to any open Drag And View window. 
Or, you can click on the "Fmlaunch" menu item that is added to Windows File Manager's 
menu bar and choose "View files".

Using the view files option will not open a new window if a window is already open.    The 
same is true if you drag files to an open Drag And View window.    However, dragging files to 
the Drag And View icon will always open a new window with the files displayed.

Every Drag And View window maintains a listing of the files that you dragged to it in its 
"Filelist" menu.    You can use the "Filelist" menu to choose a particular file in the list to view 
or you can use the "Last" and "Next" buttons to scroll through the list of files.

Drag And View includes a utility called Fileman Launcher.    which installs itself as a File 
Manager accessory in the NT File Manager.    Fileman Launcher will run Drag And View 
automatically every time you run the NT File Manager and it will exit Drag And View every 
time that you exit File Manager.    Fileman Launcher will prevent the Drag And View icon from
being covered when you are working in File Manager.    And, Fileman Launcher will remember
the place where you last left the DV icon and will place it there the next time you run File 
Manager.    You can add up to 9 other programs to Fileman Launcher and have it manage 
them the same way as it manages Drag And View.    You can access Fileman Laucher from 
the "Fmlaunch" menu item that it adds to the NT File Manager.    To add or remove programs 
or change the way Fileman Launcher runs programs, select "Modify program list" from the 
“Fmlaunch” menu.    

Drag And View supports multiple page Adobe Acrobat and spreadsheet files.    If a file has 
more than one page, there will be an active “Page” menu where you can choose which page 
to view.



Using Drag And View
If you are working in Windows 95 Explorer, right click on the file that you want to view.    If 
you want to view more than one file, first tag the files that you want to view and right click 
on them.    A context menu will come up.    Choose the “Drag And View” option from the 
context menu and a Drag And View window will open displaying the first file in the list.

Under Windows NT you can drag files from the File Manager to its icon or, you can use the 
“Fmlaunch” menu that Fileman Launcher adds to File Manager's menu bar.

All the files that you’ve dragged or right clicked on will be listed in the Drag And View 
window's "Filelist" menu and you can use that menu to display the other files.    

If you want to view two or more files in the file listing simultaneously, you can choose the 
"New" button and Drag And View will open up a new window with the same file list.    You can
open up as many windows this way as your computer's memory will support.    You can also 
drag more files to any open Drag And View window; they will be added to the "Filelist" menu 
and the first one in the group will be displayed.    The "Filelist" menu will hold up to 25 files.    
After 25, as you drag new files, the older ones will be dropped off the list.

When Drag And View displays a file, it first tries to determine if it can display the file in one 
of its special viewers.    If there is no special viewer for the file, it will be shown with either 
the ASCII viewer (if the file is made up chiefly of readable characters) or the Hex viewer.

Under Windows NT, the Drag And View icon will still remain at the bottom of your screen 
even after you've dragged files to it and opened up a viewing window.    You can continue to 
drag files to the icon and each time that you do, a new window will be opened.

Any open Drag And View window can be closed, maximized or minimized to an icon.    You 
can drag files to a minimized Drag And View window and it will be restored and display your 
files. 

When you want to quit the Drag And View Program under Windows NT    you must choose 
"Close" from the system menu of the Drag And View icon or choose “Close Drag And View” 
from the file menu of any open Drag And View window.    This is not necessary under 
Windows 95 where Drag And View will close automatically when there are no view windows 
open..    

You can also run Drag And View from the File/Run menu of any program manager. If you use 
a file name as a command line argument, Drag And View will run and display the file that 
you specified in a window. You can also install Drag And View as the viewer for other 
programs such as our Zip manager, Drag And Zip.



Uninstalling Drag And View

Under Windows 95 you can choose to uninstall Drag And View by choosing Add/Remove 
Programs from the Control Panel and then choosing to remove Drag And View for Win 32.    
Under Windows NT there is an uninstall program provided called DVUN.EXE which you will 
have to run manually.    The uninstall program will remove all the programs except the 
uninstall program itself.    You will have to remove the uninstall program manually.

To remove just Fileman Launcher you choose that option from the FMLaunch menu in the NT 
File Manager.



Selecting and Copying to the Clipboard
Selecting areas of views to copy to the clipboard is very easy with Drag And View.    Simply 
place the mouse pointer at the beginning of the area that you want to copy.    Then press the 
left button and drag the mouse to the end of the area that you want to copy, still holding 
down the left button until you are finished selecting.    You can also select the entire file by 
choosing “Select All” from the “Edit” menu.    To copy a selected area to the clipboard, click 
on the copy button or press Ctl+C or Alt+C and the selected area will be copied.    Text, 
spreadsheet or database files will be copied as text.    All graphics files will be copied as 
bitmaps.

All viewers allow selecting and copying except the WAV file player and the Hex viewer.



Settings Command (Options Menu)
Choosing this command will bring up a dialog box where you can modify Drag And View’s 
settings
The settings options are:

View Highlighted File Automatically: This option will only work when you are running Drag 
And View from Fileman Launcher or running Drag And View with Canyon Software’s file 
manager Drag And File.    If this option is turned on, Drag And View will display each file as it 
is highlighted in the file manager.    It will not open a Drag And View window if one is not 
already running.    For that you need the next option.

Open View Window if Necessary: This option works in conjunction with the previous one.    
This will open a Drag And View window to view files if one isn’t already open.

Bring View Window To Top: This option is also    designed to work in conjunction with the 
option “View Highlighted File Automatically”.    When this option is checked, the view window
will always come to the top when a new file is highlighted and consequently displayed.    If it 
is not checked, the view window will stay where it currently is.

Hide Icon: The Drag And View Icon will normally be showing on the screen when it is 
running.    Some users have requested that the icon be hidden and that they only use the 
FMLaunch menu to view files.    With this option you can make Drag And View’s icon not 
show when it is running.    After checking this option you will have to quit Drag And View and 
run it again to have it activated.

Icon Caption: Many users have requested that they be able to modify the caption of Drag 
And View icon.    In this field you can fill in whatever caption you want it to have.    If you 
leave it blank, Windows will put a blank line in reverse video under the icon.



File Formats Supported by Drag And View
File formats supported in this version of Drag And View are:

ASCII
Hex
Microsoft Word
Microsoft Word for Windows, including version 7
Microsoft Works
Microsoft Works for Windows, including version 3
Windows Write
Word Perfect
Word Perfect for Windows, including version 6
Ami Pro
Q&A Write
dBase
FoxPro
Clipper
Excel, including Excel version 6
Lotus 123
Symphony
Quattro, Quattro Pro
Quattro Pro for Windows
Windows Metafile (WMF)
Windows Bitmap (BMP)
Icon File (ICO)
PCX
GIF
TIF
JPEG
TGA
ZIP
LZH
True Type Font (TTF)

The following viewers are only in the registered version of Drag And View
CorelDraw version 3 (CDR)
AutoCad (DXF)
Micrografix Designer (DRW)
Microsoft PowerPoint (PPT)
Encapsulated Post Script/Adobe Illustrator (EPS/AI)
Hewlett Packard Graphics Language (HPGL)
Lotus (PIC)
Computer Graphics Metafile (CGM/CTM)
WordPerfect Graphics (WPG)
Adobe Acrobat (PDF)



ASCII
ASCII is the name of a character set that computers store information in.    When Drag And 
View views a file in ASCII format, it displays the files exactly as it appears on the disk and 
does not format it into a document, spreadsheet, database or graphic.    Text files stored in 
ASCII usually contain only text and no special characters to represent formatting or fonts.    
Your WIN.INI, SYSTEM.INI, CONFIG.SYS and AUTOEXEC.BAT are in ASCII format.



Hex
Hex is short for hexadecimal and is a base 16 number system.    Even though computers 
store information in binary (base 2) form, binary numbers which are made up of just ones 
and zeros are too long for displaying so base 16 is a very convenient way of looking at 
computer memory or files.    A byte, the smallest unit of computer storage can be displayed 
by just one just 2 hexadecimal digits.    

The Drag And View Hex viewer displays a file's contents as hexadecimal digits and ASCII 
characters, 16 of them on a line.    The display consists of three columns.    The first column 
consists of the offset into the file in hexadecimal.    The second column has the next 16 bytes
of the file displayed as 16 hexadecimal numbers.    And, the third column has the same 16 
bytes displayed as ASCII characters.



Word Wrap
Word wrap is a feature that many word processors and viewers use to display and print text 
so text does not go off the right side of the screen or page.    Drag And View will word wrap a 
line of text when it gets too long do display in the current window.    Instead of just breaking 
the text in the middle of a word, Drag And View will break the text between words so the 
text is still readable after it is wrapped.



Last
The "Last" and "Next" buttons allow you to scroll through the files in a Window.    These 
buttons won't be active unless the Filelist menu has more that one file in it



Next
The "Last" and "Next" buttons allow you to scroll through the files in a Window.    These 
buttons won't be active unless the Filelist menu has more that one file in it.



Play
The play button will only be active when you have dragged a Wav file to Drag And View.    A 
Wav file is a Windows sound file and it has a "WAV" extension.    When you drag a Wav file to 
Drag And View, DV will try to play the Wav file if you have a sound driver installed.    If you 
want to hear the Wav file again, click on the Play button.



Flip Top to Bottom (Rotate Menu)
This option allows you to rotate a bitmap 180 degrees.



Reverse Left to Right (Rotate Menu)
This option allows you to reverse a bitmap left to right.



Rotate 90 Degrees (Rotate Menu)
This option allows you to rotate a bitmap 90 degrees.



Configure Toolbar
Drag And View's button toolbar is very easily modified allowing you to add and delete 
different buttons.    Programs can also be added to toolbar buttons.    All toolbar buttons can 
be configured to user Alt or Ctrl key combinations as hot keys.    Alt hot keys are shown in the
lower right of the button as black on gray.    Ctrl hot keys are shown as white on black.    
There is also an option to completely hide the toolbar.    If the toolbar is hidden, the 
configured hot keys are still active.
To modify the toolbar:

1. Choose Customize Toolbar from the Options menu.

In the list box on the left appear the available button choices.    The top entries is SEPARATOR.    
SEPARATOR adds a space between two buttons. In the list box on the right appear the buttons that 
are currently part of the toolbar along with their hot keys.    

To add a new button
1 Select the position in the Toolbar buttons list box where you want the button to appear.    The new 

button will appear before the selected button.    You can also drag buttons in the Toolbar buttons 
list box to modify their position.

2. Select the button that you want to add from the Available buttons list box.    You can also choose 
SEPARATOR.    If a command button is already in the Toolbar buttons list box, it won't be in the 
Available buttons list.

3. Choose Add or drag the button to the right hand list box.    The button will be added.
To remove a button

1. Select the button that you want to remove from the Toolbar buttons list box.    Click on Remove or 
drag the button to the left hand list box.    The button will be removed.

To add or change a button hot key
1. Highlight the button whose hot key you want to change or add.    Select the letter of the hot key 

that you want to use from the drop down list box in the lower right of the Customize Toolbar dialog
box.    Choose Alt or Ctrl if you want the hot key to use the Alt key or the Ctrl key.    

When you are finished making changes to the toolbar, choose OK.    All changes will be saved
and windows updated.    If you choose a hot key that is already in use, you will be warned 
before saving the new hot key.



What is Shareware
Shareware is a method of marketing software where the user gets to try a fully functional 
version of the program before deciding to buy it or not.    Many of you probably have done 
this with non Shareware software because you wanted to make sure that you liked the 
program before you actually spent money on it.    With software that isn't Shareware, you are
violating the software's copyright when you do that.    With Shareware, you are expected to 
try out the software without first paying for it, but if you continue to use it after the trial 
period you are also violating the software's copyright.    Paying for Shareware is often called 
registering it

Drag And View is available as Shareware from many bulletin boards and disk vendors.    You 
are welcome to take a copy, install it on your computer and use it.    The trial period is 30 
days.    

If you like Drag And View and you find that you continue to use it after the 30 day trial 
period, you are required to register it.    That way you can continue to use it and not be 
breaking any laws.    More importantly, by registering the program, you are acknowledging 
that you like the program and find it useful and you are helping Canyon Software to continue
to produce programs that you will like. The registered version of Drag And View comes with 
additional file viewers that cannot be distributed as Shareware, a printed manual and 30 day
money back guarantee.    Registered users are also eligible for free technical support by 
phone, mail, fax, CompuServe or America On Line.

Additional viewers in the registered version of Drag And View are:
AutoCad (DXF)
CorelDraw version 3 (CDR)
Computer Graphics Metafile (CGM)
Micrografx Designer (DRW)
Adobe Illustrator/Encapsulated Postscript (AI/EPS)
HP Graphics Language 
Word Perfect Graphics (WPG)
Lotus (PIC)
Microsoft PowerPoint (PPT)
Adobe Acrobat (PDF)



REGISTRATION FORM

Orders Only 1-800-280-3691
Your registered version of Drag And View will come with additional viewers for

Microsoft PowerPoint (PPT)
AutoCad (DXF)
CorelDraw version 3 (CDR)
Computer Graphics Metafile (CGM)
Micrografx Designer (DRW)
Adobe Acrobat (PDF)
Adobe Illustrator/Encapsulated Postscript (AI/EPS)
HP Graphics Language 
Word Perfect Graphics (WPG)
Lotus (PIC)

____ Drag And View for Windows 95/NT
diskette, manual @ $35 ea $________

____ Drag And View 95 with Drag And Zip 95
( Our Windows Zipper ) both regularly $65 @ $55 ea $________

____ Drag And View 95 with Drag And File 95
( Our Fabulous File manager ) both regularly $70 @ $55 ea $________

____ Drag And View 95 with Drag And Zip 95 and
Drag And File 95 regularly $100  @ $69.95 ea $________

Subtotal $________

Shipping outside of the United States @ $5 $_________

California residents please add 7.25% sales tax: $________

Total $________

                                        Diskette size      3 1/2" [ ]      5 1/4" [ ]

All orders will be send by US mail unless requested otherwise. 

Prices subject to change without notice.

Orders Only 1-800-280-3691
Master Card ,Visa Orders and AMEX.    You may call in your registrations to Canyon Software 
at (415) 415 453-9779 fax them (415) 453-6195 or send in this form with the information 
below.



Click here for overseas registration points.

Name As It Appears On Credit    Card ________________________________________________________

Credit Card Number # ______________________________________________

MC [ ]    VISA [ ]    AMEX[ ]

Expiration Date ___/___

Name:__________________________________________________

Company:_______________________________________________

Address:________________________________________________

_______________________________________________________

Where did you obtain Drag And View ________________________

Any comments, suggestions or bugs?    

_______________________________________________________

_______________________________________________________

________________________________________________________

Please make checks payable to:

Canyon Software
1537 Fourth Street Suite 131
 San Rafael, CA 94901

My name is Dan Baumbach I am a member of ASP., The Association of Shareware 
Professionals.    I can be reached either at the above address, on CompuServe electronic mail
74774,554, AOL DanBCan, Internet, support@canyonsw.com or at (415) 453-9779, fax (415) 
453-6196.    Thank you for your registration.

The program author, Dan Baumbach, is an active member of the Association of Shareware 
Professionals (ASP).    ASP wants to make sure that the Shareware principle works for you.    If
you are unable to resolve a Shareware-related problem with an ASP member by contacting 
the member directly, ASP may be able to help.    The ASP Ombudsman can help you resolve 
a dispute or problem with an ASP member, but does not provide technical support for 
members' products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, 
MI 49442, or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536.



Overseas Purchases

Australia
Denmark
France
Germany and Austria
Japan
United Kingdom
Holland



Australia

BudgetWare
PO BOX 496
Newtown NSW 2042
Australia
Phone (02) 519-4233
Fax (02) 516-4236



France

Jean-Guy DUCREUX (aka Winnie)
WindowShare SARL
B.P. 2078
57051-METZ cedex 2
France
Phone 87 30 85 57
Fax 87 32 37 75



Denmark

PRO SOFT
v/ Jens Rex
Benloese Skel 4 G
DK-4100 Ringsted
Denmark



Germany

DER PD PROFI
Gerd Zöttlein
Schulstraße, 13
D-86666 Burgheim
Germany
Phone 0 8432-1296
Fax          0 8432-8674



Japan

Personal Data Factory
Shimoueki-cho 451-3
Isesaki-shi
Gunma-ken 372
Japan



United Kingdom

Nildram Software
82 Akeman Street
Tring
Herts
HP23 6AF
United Kingdom
Phone (0442) 891331 
Fax        (0442) 890303



Holland

BroCo Software
P.O. Box 446
3760 AK SOEST
The Netherlands
Phone 035-626650
Fax        035-6014012
email 100410.3555@compuserve.com




